Joint Forces within the Ankle
during Level Walking

Mike Arakilo

The web cast will start in a few minutes....

Why not spend the time checking these points:

Does your screen fit the presentation?

Try this:

The “Sharing” menu (upper right corner)->View->Autofit

Is your system set up to receive the broadcasted sound?
Please follow these instructions to set up the audio:
www.anybodytech.com -> Webcasts (bottom of the page)
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Purpose of the Project

“Virtual Assessment of the Latest
Generation of the Total Ankle
Replacement Using Motion Analysis “

Investigate the reasons for ankle joint replacement
failure and possibly optimise ankle prosthesis
design.
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More Perspectives

 TAR perspective Is part of this work
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e« Same work can be done for other many
activities ...
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More Activities ...

Optimizing new designs related to human
health i.e. new prosthesis designs , new
designs for cars, seats, ...

Reference: www.google.co.uk A N Y
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More Activities

Enhancing human conditions in
various locations i.e. muscular
activities for athletes, bone
loss/gain for astronauts

Reference: www.google.co.uk
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Can you Hear me?

Does your screen fit the presentation?
Try this:
The “Sharing” menu (upper right corner)->View->Autofit

|s your system set up to receive the broadcasted sound?
Please follow these instructions to set up the audio:
www.anybodytech.com -> Webcasts (bottom of the page)
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Brief Summary of the Talk

e Total Ankle Replacement (TAR) has a lack of
reliability over the long term as a result of few

number of investigations compared to THR and
TKR

 Few Ankle Joint Forces data is available through
literature and go back to the 1970s ...
Compared to 2008 !

 New model design for Collecting MoCap Data
and investigate the resultant musculoskeletal
and ankle joint forces in AnyBody
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Why TAR ?

e Treatment of ankle
joint diseases,
Osteoarthritis

e TAR maintains
normal motion of the
joint and distribution e o
of loads on the
surrounding Sl g
structures
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Questions, It Is ok to ask

e Launch the-
Q&A panel
here.

 Type your
guestions in the -
Q&A panel.

 Send the
guestion to
"Host, Presenter
& Panelists”

Type your question here. (256 characters max)

. | Host

Host
Fresanter
Huost & Presenter

All Panelists
Mic Dams

Notice the answer displays next to the question in the Q&A box. You

may have to scroll up to see it.
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Drawbacks of TARs

Small size of the joint
High resultant Moment
High Stress, High Compressive Forces

Disregard for anatomic component shape
and physiological ankle biomechanics

Poor reproduction of the normal
mechanics of the ankle
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Avallable Data on Ankle Joint
Forces

“Forces and Motion Analysis of the Normal,
Diseased and Prosthetic Ankle Joint”

Richard N Stauffer 1977
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Ankle Joint Forces In Literature
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Ankle Joint Forces In Literature

PHASE 2
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Ankle Joint Forces In Literature
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Ankle Joint Forces In Literature

Forces were calculated:
— Fa tensile force in Anterior Tibial Tendon
— F« tensile force in Achilles Tendon

—Fn~ compressive forces across Ankle Joint

— 1 tangential forces across Ankle Joint

o
e
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Aim of this Study

e Lack of knowledge on ankle joint internal
forces

 Knowledge important because TAR not so
reliable

Improve Data and
hence Design !
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Methodology

Gait Experimental: Vicon Model Simulation: AnyBody
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Gait Experimental

Gait Data Collection Using

Vicon System

— Custom Model definition with 22

markers (MikeArakiloGait)

» LASI, RASI, LPSI, RPSI

LTHI, RTHI, LKNEE, RKNEE
LTIB,RTIB
LANK, RANK, LMANK, RMANK
LHEE, RHEE, LTOE, RTOE
LIMEH, RIMEH, LSMEH, R5MEH

Y V V V V

TECHNOLOGY



Gait Experimental

Methodology being adopted

Gait Data Collection using Vicon System®

» Vicon Cameras MxF40
v’ 8 Cameras used
v' 4 Megapixel
v' Data taken at 50 Hz

Prospective Data to be taken on 120 Hz
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Gait Experimental

Methodology being adapted

Gait Data Collection using Vicon System

» KISTLER FORCE PLATES
» 8 Channels: 4 on Z-D, 2 on X-D and 2 on Y-D
» Analogue Data at 1000 Hz
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AnyBody Model

Methodology being adapted

Purpose of AnyBody Gait Model

W < Construct a musculoskeletal body computer stimulation of
' the ankle joint. The model will then be employed to predict
the forces transmitted through the joint and surrounding
tissues.
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AnyBody Model

escription of Gait Model

R/

s Anybody Musculoskeletal
Model with no Muscles on the
Trunk

* Anybody TLEM Model of the
Leg:
v" More Sophisticated Muscles

v" More Muscles around the
ankle Joint

s Ankle with 2 separate
REVOLUTE joints:

v' Subtalar Joint
v Ankle Joint

L)
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AnyBody™ Model

Muscle Recruitment Solver:
e MinMax Solver
e Quadratic Solver

Forces Collected:

e GRF Ankle Joint

« Achilles Tendon
 Tibialis Anterior/Posterior
e Peroenus
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Simulation Results of the Gait

t= real time gait during walking

Animations are available through email A N Y B 0 D Y



GRF Ankle Joint

Ankle GRF, Right Leg, Minkax
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GRF Ankle Joint

Ankle GRF, Left Leq, Mintlax
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GRF Ankle Joint

Ankle GRF, Right Left Leq, Minhdax
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GRF Ankle Joint

Ankle GRF Right Leg, QP
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GRF Ankle Joint

Ankle GRF, Left Leg, QP
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GRF Ankle Joint

Ankle GRF, Right Left Leg, QP
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GRF Ankle Joint

MinMax Solution Quadratic Solution
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GFR Ankle Joint Vector

MinMax Solution Right QP Solution Right
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GFR Ankle Joint Vector

MinMax Solution Left QP Solution Left
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GRF Ankle Joint Vector
Comparison !

QP =——Minlax
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GRF Ankle Joint Vector
Comparison !

QP Left =—=MinMax Left
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GRF Ankle Joint

Force Vector Quadratic Force Vector MinMax
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* Right Ankle Total Forces Vector
» Comparison between Quadratic and Simple Solution
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GRF Ankle Joint
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Forces Acting on the Achilles

Forces Acting onthe achilles, Right Leg, Minhkdax
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Forces Acting on the Achilles

Forces Acting on the Achilles, Left Leg, Minhdax
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Forces Acting on the Achilles

Forces Acting on the Achilles, Right Left Leq, Minhax
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Forces Acting on the Achilles

Forces Acting on the Achilles, Right Leg, QP
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Forces Acting on the Achilles

Forces Acting onthe Achilles, Left Leg, QP
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Forces Acting on the Achilles

Forces Acting on the Achilles, Right Left, QP
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Forces Acting on the Achilles

MinMax Solution Quadratic Solution

510 EE]
M CpEERaTy Culoud Abscisat

ANYBODY

TECHNOLOGY



Tibialis Anterior Forces

MinMax Solution Quadratic Solution
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Tibialis Posterior Forces

MinMax Solution Quadratic Solution
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Peroenus Forces
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Peroenus Forces

Feroenus

Forces, Left Leg, Minhdax
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Peroenus Forces

Feroenus

Force

5, Right Left Leg, Minkiax
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Peroenus Forces
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Tibialis Posterior Forces

MinMax Solution Quadratic Solution

Percenus Forces, Right Left Leg, MinMax
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Muscle Activity

Wuscle Activity, Minhiax
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Discussion

Achilles
Tendon
Forces
—1
- A
PlantarFlexion
of the Ankle PlantarFlexion

Ll

v of the Ankle
—

GRF Data
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Discussion

Robust Reliable
Data Forces

Plantar N
Flexion of

the Ankle
(_Sﬂ—)

Achilles
Tendon
. Forces J
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Discussion

Forces Computed in the ankle DO NOT
depend on the recruitment solver in
AnyBody

More Interesting ! ...
Importance of the Muscle

Not a problem in AnyBody : more
muscles than degrees of freedom.
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Summary

Present TARs are among the joints
replacement that don’t have reliable
results

Further Joint Data needed for investigation

Data Collected in Vicon and Processed In
AnyBody

Results lie in an acceptable range
e Therefore ...
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Current/Future Work

 Use an FE Model to investigate forces and
on the bones and stresses on the
Prosthesis (work in progress)

e Collect data from a defined Normal and
Diseased population

* Process Data and Compare !
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In Order To Achieve this Work

We need to get TARs samples as well as
TARs CAD file.

Collaboration will be made.
Confidential Treatment of files.

Study will be done using those TARs and
hence more logical and realistic
Improvements can be achieved.
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In Order To Achieve this Work

o Opportunity to make a business and/or
financial collaboration

* Financially and Personally difficult to rely
on my family and meet the cost of living
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Contact Options

e Mike Arakilo

PhD Biomedical Engineering

m.arakilo@dundee.ac.uk
Mob: +44 7864 922291 Tel: +44 1382 496322

« University of Dundee
College of Medicine, Dentistry & Nursing

Ninewells Hospital & Medical School
TORT Centre, Dundee DD1 9SY, Scotland, UK
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Thank You ...

The next webcast hosted by AnyBody Technology will be held on

January , 22nd 2009.

Title:

“Optimization of implant and prostheses design with AnyBody -
boundary conditions for FE Analysis", by Alexander Nolte, CADFEM

GmbH. “

We hope to meet you there...

Special Thanks to :

My Supervisor : Dr Tim Drew

John Rasmussen (Aalborg University)
Arne Kiis (Anybody Technology)
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Q&A Panel

Launch the-

Q&A panel

here. ————
-~ | O%A [?] R —

Type your

guestions in the

Q&A panel.

Sendthe @ = :_ _ HDS‘ ____________________________ |
guestion to
"Host, Presenter
& Panelists”

Type your question here. (256 characters max)

Host
Fresanter

Huost & Presenter
Host Presenter & Panelisis

All Panelists
Mic Dams

Notice the answer displays next to the question in the Q&A box. You

may have to scroll up to see it.
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